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DISCLAIMER

The information in this manual is furnished for informational use only and subject
to change without notice. While every effort has been made to ensure that the
information contained in this user manual is accurate, up-to-date and reliable,
EVS Broadcast Equipment cannot be held responsible for inaccuracies or errors
that may appear in this publication.

IMPROVEMENT REQUESTS

Your comments will help us improve the quality of the user documentation. Do not
hesitate to send improvement requests, or report any error or inaccuracy on this

user manual by e-mail to doc@evs.tv.

REGIONAL CONTACTS

The address and phone number of the EVS headquarters are usually mentioned in
the Help > About menu in the user interface.

You will find the full list of addresses and phone numbers of local offices either at
the end of this user manual (for manuals on hardware products) or on the EVS
website on the following page: http://www.evs.tv/contacts

USER MANUALS ON EVS WEBSITE

The latest version of the user manual, if any, and other user manuals on EVS
products can be found on the EVS download center, on the following webpage:
http://www.evs.tv/downloadcenter
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1. Introduction

The EVS FCP Export Plug-in is a plug-in designed for Apple Final Cut Pro. Its
purpose is to export a sequence edited in Final Cut Pro to the EVS environment
(EVS video server or nearline storage).

The EVS Export Plug-in first exports a QuickTime Reference file with the FCP
sequence settings. It can also send additional XML jobs to XTAccess for post-
processing, such as restoring to an EVS video server or transcoding to a file (to
generate a proxy file, for example).

1.1 MEDIA FLOWCHART

The general flowchart of the EVS FCP Export Plug-in is described below:

e =%
Apple Flnal Cut Pro

EVS FCP Exporter Plug-in

DO, [
FCP Exported Files EDL Storage
QuickTime Reference

-—
T e

Post Processing XTAccess

XT -
- Files on nearline storage

EVS server backup

EVS server main XML job
—_—

AN data flows out
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Once the FCP sequence is ready for broadcast, the editor will export it to the EVS
system. Several actions will be initiated:

Consolidate the sequence and create a QuickTime Reference on a temporary
storage or nearline storage (1).

o0 Optionally: Create an XML file along with the exported QuickTime
Reference file to reference this file in an IPDirector nearline storage

o0 Optionally: Export the sequence as an FCP EDL (XML) on a storage (2).

Post-Processing: Generate XML jobs (3) to EVS XTAccess application in order
to:

0 Restore the exported QuickTime Reference file to EVS servers (Main
and/or backup) (4 & 5).

0 Rewrap the exported QuickTime Reference file to another file (for example
to generate a proxy file with a transcoding job) (6)

The post-processing jobs are monitored and their status is displayed in a
separate window.

MAIN FEATURES

The Post-Processing can be started during the FCP export as the QuickTime
Reference file can be opened during creation.

Multiple post-processing jobs can be generated at once.

An XML metadata file can be customized to allow metadata movement from
Final Cut Pro to EVS (VarlD, Source Name, IPD owner).

Referencing into the IPDirector database is supported.

All EVS servers’ native codecs integrated with FCP are supported: DVCPRO50,
IMX-D10 (30/40/50), DVCPRO HD, Apple ProRes 422 (LT/SQ/HQ) in all video
formats (1080i50, 1080i5994, 720p50, 720p5994).
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2. Hardware and
Software
Requirements

2.1 HARDWARE REQUIREMENTS

e Apple workstations supporting the Final Cut Pro application

e No other specific requirement

2.2 SOFTWARE REQUIREMENTS

e Mac OS X 10.5 (Leopard) or 10.6 (Snow Leopard)
e Final Cut Pro 7+
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3. Installation Procedure

1. On the Mac device, launch the package EVSPlugin 2.0.22.dmg

-

NaNé __| EVSPlugin v2.0.22 —
- 1 of 1 selected, 9,7 MB available — A

Follow the instructions.
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Welcome to the EVS Export Plugin for Final Cut Pro Installer

& Introduction
® Destination Sele
@ Installationdliy

® Installations =
[ Summaﬁ .ri

I||-1"

l-ill!.| ll.h1| i 11‘

LT 2 5

e
B 1

You will be guided through the steps necessary to
install this software.

[ GoBack (_Cuntinue )

2. Specify the destination folder in the Destination Select step

3. Select the Standard Installation type in the Installation Type step.

4

Standard Install on “Macintosh HD”

& Introduction
& Destination 5e
© Installation T
® Insta]latiéﬁ .
[ ] Summaﬁ ,.i

iy

! Imn 1ml|_|||ur
||1|l|.l|u|||l||||||n|| IL )

o . |

This will take 639 KB of space on your computer.

Click Install to perform a standard installation of
this saftware on the disk "Macintosh HD".

(_ Change Install Location... )

4. Enter a login/password:

( Go Back ;l ( Install )

A
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Type your password to allow Installer to make
changes.

Name: Media_MAC

Password: ssssss

b Details

@ CEantel)E OK )

5. Click OK to validate and start the installation.

The installation was completed successfully.

@ Introduction
& Destination 5e

@ Installatio

& Installation ?
F)

© Summary The installation was successful.

mlllmnlulurllul'a
"“w”rmll“”. ‘ : . The software was installed.

o 1

” GoBack ) E—Eluse—a
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4.1
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4. Configuration

You need to launch the EVS FCP Export Plug-in to configure it.

LAUNCHING THE PLUG-IN

To launch the plug-in, select File > Export > Export to EVS:

New
New Project 38N
Open... 8O
Open Recent >
Close Window B/W
Close Tab ~W
Close Other Tabs

Close Project

Save Project
Save Project As... {+38S
Save All NS
Revert Project

Restore Project...

Import

Share...

QuickTime Movie... HE

Send To Using QuickTime Conversion...

Batch Export

z For Soundtrack
Batch Capture... ~C For LiveType
Log and Capture... 8

Log and Transfer... {r328 Audio to AIFF(s)...

Media Manager... Audio to_OMF...
Reconnect Media... Automatic Duck Pro Export FCP...

Set Logging Bin B?t':h st .
Cinema Tools Audio EDL...
Print to Video... ~M Cinema Tools Change List...

Cinema Tools Film Lists...
EDL...

Export to EVS
MXF4mac GC...
Markers List as Text...
Sony XDCAM...

XML...

Edit to Tape...

The EVS FCP Export Plug-in opens in a separated window:
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EVS - Export
v2.1.2
Sequence: DVCPRO HD 1080i PAL !vs
Profile: | Production s ]
¥ Hide details

[ﬂ Export QuickTime reference movie

Destination folder: [ Axinoe » | Change...

smb:y fxstore60170/IPD/ Axinoe

™ Export XML MetaData file [ MetaDatas Settings. ..

Destination folder: () Use QuickTime ref. movie export folder
%) Use custom folder:

[ ] Axinoe v | Change...

smb:/ /x5tore60170/IPD/Axinoe

@ Create XTAccess Jobs

Add one or more XT Targets below:

Storage

XT Main

= %

E Export EDL

Destination folder: [ RAN : | Change...

=l

smb://xstorec0170

[ Save Profile ) (" Cancel ) ( Export )

SELECTING AND DEFINING PROFILES

The configuration settings of the Plug-in can be saved as ‘Profiles’. A profile
regroups the settings of a specific configuration that will be processed by the EVS
FCP Export Plug-in.

SELECTING PROFILES

Right-click the profile to display the list of profiles:

( — . |
. AFP I
WL FIBER :ws

Sequence ;
poi

Profile ¥ Production B
ran

¥ Hide details rewrap

rewrap (copy)
E Export QuickTime n
Manage Profiles...
Destination folder: ~pErwocmoe: + |_Change...

smhb: [/xs5toreG0170/IPD/Axinoe

You can select the profile to use. The profile displayed on the plug-in window is
the current profile.
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4.2.2 MANAGING PROFILES

Profiles can be managed via the Manage Profiles command at the end of the
Profile list:

Profiles -
AFP

FIBER

poi

ran

rewrap .
rewrap (copy)

- i

Duplicata

o
|

You can perform the following actions:

e Add a new profile (+ sign)
e Delete an existing profile (- sign on selected profile)
o Duplicate a profile (useful to avoid creating a new profile from scratch)

e Rename a profile

@ Note
You must press ENTER to validate a change in the profile name.
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EXPORTING QUICKTIME REFERENCE
MOVIE

E‘T Export QuickTime reference movie

Destination folder: [ Axinoe » | Change...
smb:f/xstore60170/IPD/ Axinoe

When you select the option Export QuickTime Reference Movies, the EVS FCP
Export Plug-in will export the selected FCP Sequence as a QuickTime Reference
file.

The codec and video format is automatically selected using the currents settings
of the FCP Sequence to export. The export will only re-encode the portion of the
sequence needed (smart export). The following codecs are supported:

DVCPRO50 (PAL/NTSC 29.97)

IMX 30/40/50 (PAL/NTSC 29.97)

DVCPRO HD (1080i50, 1080i5994, 720p50, 720p5994)

Apple ProRes 422 (LT, SQ, HQ) (1080i50, 1080i5994, 720p50, 720p5994)

S_‘%;‘)? Note
Please make sure that your Sequence settings are in one of the above,
natively supported formats

o Destination Folder: the destination folder to store the QuickTime Reference
file can be selected using the Change button. The path is also displayed.
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4.4

44.1

4.4.2

EXPORTING THE XML METADATA FILE

EXPORT OPTIONS

E[ Export XML MetaData file MetaDatas Settings. ..

Destination folder: () Use QuickTime ref. movie export folder
{*) Use custom folder:

[ Axinoe v | Change...

smb:f/xstore60170/IPD/ Axinoe

When you select the Export XML Metadata File option, the EVS FCP Export Plug-
in will generate an XML metadata file along with the exported media (QuickTime
Reference).

e Destination Folder: you can select one of the following options to specify the
destination folder to store the XML Metadata file:

0 Use QuickTime Ref. movie export folder: to store the XML in the same
folder as the exported QuickTime Reference media.

0 Use a custom folder: to select a specific folder for the XML Metadata file.
The path can be selected using the Change button. The path is also
displayed.

CUSTOMIZATION OF METADATA SETTINGS

It is possible to customize some of the metadata generated by the FCP exporter.

Click the Metadata Settings button. The following dialog box opens:

ar
a4)

VarlD: | Sequence Name

Source: fecp

Owner: ran

( Cancel ) OK 3

e VarlID: You can define one of the following parameters for the <XT_VarlD>
field:

0 Sequence Name: the VarlD is the exported Sequence Name truncated to
the 32 first characters.

o0 Automatically Generated: The VarlD will be automatically generated.
e Source: The <XT_ClipldSrc> can be entered as free text.

e Owner: The IPDirector <Owner> can be entered as free text.

All other metadata is extracted from the FCP Sequence settings.

11
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@ Note
The XML metadata is extracted from a template
MetaDataTemplate.xml. This template can be accessed by
extending the plug-in package by ‘Show Package Contents’. The
template is stored in the sub-folder: Contents/Resources/.

For more information, see section 7.4 ‘XTAccess Metadata’ on page 25.

4.5 CREATING POST-PROCESSING
XTACCESS JOBS

4.5.1 INTRODUCTION

The EVS FCP Export Plug-in can generate XML jobs to be processed by
XTAccess. XTAccess will use the exported QuickTime Reference Movie file as a
source to be processed to a new target. Possible post-processing jobs are:

e Restore to an EVS Server

e Rewrap to a File.

fﬂ Create XTAccess Jobs

Add one or more XT Targets below:

Storage

XT Main

45.2 MANAGING POST-PROCESSING XML JoBS

The Post-Processing XML jobs are listed in the main configuration window.
You can manage the list of post-processing jobs in the following way:
e Add a new XML job (see below)

e Delete an XML job
N

Edit

Duplicate
Rename

e Duplicate an XML job (useful to avoid creating a new XML jobs from scratch)

e Rename an XML job

Note
"»% You must press ENTER to validate the change in an XML job name.

12
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45.3 CONFIGURATION OF POST-PROCESSING XML JOBS

When adding a new XML job, a configuration window is displayed.

Target name:

XML Job Path:
lob Type:

XTAccess path:

IP Address:

TCP Port:

FTP Login:

FTP Password:

XML Referencing path:

Location on XT Server:

kT Main

|_1Jobs_Incoming

| Restore to XT = ]

» [ Choose...

\Wstoree0170\ranIPDY

# Delete source file after jobs
@ Create new asset

|| Send XML job when FCP Expart is over

172.22.51.3

21

avs

\\ipdtest\ref\TO_TODOY

3117

Cancel

) oS

The following elements can be configured for a Post-Processing XML job:

e Target Name: A ‘nickname’ for the user, this target name can be freely
modified. This name references the XML job in the Profile Configuration

window.

e XML Job Path: You must select the folder where the XML job will be posted.
This folder MUST be scanned by an XML Scan process in XTAccess.

Example: \device\XTAccess XML\Jobs Incoming\

e XTAccess path: XTAccess must be able to access the exported QuickTime
Reference file. This field defines the UNC path of the QuickTime Reference
movie, from the perspective of the XTAccess application.

13
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e Options:

o Delete Source File after jobs: Select this option to delete the source file
(the exported QuickTime Reference file) when the job is successfully
completed. In case the source file is used by another application (or
another job), the file will not be deleted.

o Create a new asset: Select this option to create a new Asset GUID in
IPDirector database.

o Send XML jobs when FCP export is over: Select this option to send the
XML jobs when the FCP export has been processed. In this case XTAccess
will only handle exported QuickTime Reference files which are ‘closed’ (not
growing). Some file systems do not correctly report growing status, and
therefore this option could be a ‘workaround’.

Two types of XML jobs are available:

Rewrap

e Restore to XT: Copy File To XT job (Job type #2)
e Rewrap: Rewrap to File (Job type #40)

The configuration of each type of job is detailed in the sections below.

45.4 CopPY FILETO XT

When you select Restore to XT, the following parameters must be configured.

IP Address: 172.22.51.3

TCP Port: 21

FTP Login: evs

FTP Password: sese

XML Referencing path: \\ipdtest\ref\TO_TODO

Location on XT Server: 3117

e |P Address: Enter a compliant IP address of the target EVS server as free
text.

e TCP Port: Enter a compliant TCP Port (typically 21) as free text.

e FTP Login : Enter the FTP login on the EVS server (typically: evs) as free
text.

e FTP Password: Enter the FTP password on the EVS server (typically: evs!) as
free text.

e Location on XT Server: Enter the location of the clip on the EVS Server as
free text. It must be in the format ‘XXX?' where ‘XXX’ is the LSM ID at which
the FCP exporter will begin clip creation.

The format XXX[ABCD] is NOT supported.

14
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0 Note

The FCP exporter will attempt to create the new clip in the ‘A’ position,
followed by the ‘B’ position, and so on up until the ‘F’ position. If the
LSM ID specified is already used, the FCP exporter will automatically
increment to the next LSM ID until a free position is discovered.

e Options:

0 XML referencing path: Enter the IPDirector XML Referencing path as free
text. This is an option if you want to reference the newly created clip in the
IPDirector database.

4,55 REWRAPTO FILE

When you select Rewrap, the following parameters must be configured.

Destination File Path: \\xstoreG0170\ran\ipd\

Destination File Format: | EVS MXF 5 ]
E Cenerate XML MetaData

XML MetaData path: \\xstore6D170\ran\ipd\bbb\

e Destination File Path: The UNC path where the file will be stored.

e Destination File Format: You can select the file format from a list:

EVS MXF
MXF OP1a (XDCAM)
QuickTime Movies

Avid MXF OPAtom
AV

| MXF OPla (SMPTE)
DV-DIF

o0 EVS MXF: The legacy EVS MXF format (valid for DVCPRO50, IMX,
DVCPRO HD and Apple ProRes 422 codecs)

0 MXF OPla (XDCAM): The XDCAM MXF OP1la format (valid for DV25 and
IMX codecs)

0 QuickTime Movies: The self-contained QuickTime Movies format (valid for
DV25, DVCPRO25, DVCPRO50, IMX, DVCPRO HD and Apple ProRes 422
codecs)

0 QuickTime Reference: the Reference QuickTime Movies format (valid for
DV25, DVCPRO25, DVCPRO50, IMX, DVCPRO HD and Apple ProRes 422
codecs)

0 Avid MXF OPAtom: the native MXF format supported by Avid NLE (valid
for DVCPRO50, IMX and DVCPRO HD codecs)

o AVI: Not used

15
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0 MXF OPla (SMPTE): the MXF OP1la format compliant with SMPTE (valid
for DVCPRO50 and DVCPRO HD codecs)

o DV-DIF: the raw DV-DIF format (valid for DVCPRO50 and DVCPRO HD
codecs)

e Options

0 Generate XML Metadata: Select this option to generate an XML metadata
file along with the destination file (generated by XTAccess)

0 XML referencing path: Enter the IPDirector XML referencing path as free
text. This is an option if you want to refer the clip on EVS video server in
the IPDirector database.

EXPORT FCP EDL (FCP XML)

@Expurt EDL

Destination folder: [l RAN » | Change...

smb: [ /xstore60170

When you select the option Export EDL, the EVS FCP Export Plug-in will export
the selected FCP Sequence as a FCP XML.

e Destination Folder: The destination folder to store the EDL (FCP XML) file
can be selected using the Change button. The path is also displayed.

DUPLICATE THE CONFIGURATION ON
ANOTHER FCP DEVICE

It could be useful to configure the EVS FCP Export Plug-in on one device, and
once the settings are validated, to copy the complete configuration on the other
FCP devices.

This is possible by copying the complete folder Library/Application
Support/EVS/
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5. How to Export an FCP
Seguence

PROCEDURE

To export an FCP Sequence to EVS, proceed as follows:
1. In FCP, select the sequence to export.
2. Select File > Export > Export to EVS.

New

New Project 38N
Open... ¥O
Open Recent »
Close Window ‘W
Close Tab ~W

Close Other Tabs
Close Project

Save Project
Save Project As... 1385
Save All S
Revert Project

Restore Project...

Import

Share...

QuickTime Movie...
Send To Using QuickTime Conversion...
Batch Export

For Soundtrack
Batch Capture... ~C For LiveType

Log and Capture... 388 .
Log and Transfer... {38 Audio to AIFF(s)...

Media Manager-... Audio to_OMF...
Reconnect Media... Automatic Duck Pro Export FCP...

Set Logging Bin B?t':h st .
Cinema Tools Audio EDL...
Print to Video... ~M Cinema Tools Change List...
Edit to Tape... Cinema Tools Film Lists...
EDL...

Export to EVS
MXF4mac GC...
Markers List as Text...
Sony XDCAM...

XML...

This launches the EVS FCP Export Plug-in in a separate window:

17
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EVS - Export

v2.1.2
Sequence: DVCPRO HD 1080i PAL ¢

Profile: | Production f

4k
R

¥ Hide details

E Export QuickTime reference movie

i

Destination folder: [ Axinoe » | Change...
smb://xstore&0170/IPD/Axinoe
E Export XML MetaData file | MetaDatas Settings. .

Destination folder: () Use QuickTime ref. movie export folder
{*) Use custom folder:

&

[] Axinoe » | Change...

smb:/ fxstore60170/IPD/Axinoe

@ Create XTAccess Jobs

Add one or more XT Targets below:

Storage

XT Main

+ | = | -

E Export EDL

Destination folder: [l RAN + | Change...

smb:{/xstore60170

[ Save Profile ) ': Cancel :‘ ( Export )

3. Select a profile in the Profile drop-down list.
4. Check the configuration settings, and modify them if needed.

For more information, refer to the chapter 4 ‘Configuration’, on page 7.

5. Select Export to start exporting the sequence.

RESULTS

FCP will display a transfer window displaying the status of the export.

e The XML Metadata file (if selected) is generated before the export is started
(to generate a reference in the IPDirector database before the export has been

completed)
e The FCP EDL (if selected) is generated before the export is started.

The post-processing XML jobs are started once the export has written sufficient
data to allow XTAccess to read the source file (or at the end of the export based
on the export option selected - see section 4.5 ‘Creating Post-Processing
XTAccess Jobs’).
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e The delay between the start of the export and the post of the XML job can be
configured (see section 7.2 ‘Delay to launch the Post-Processing Jobs’).

e The status of the post-processing can be monitored on the FCP station (see
section 6 ‘"How to Monitor the Post-Processing XTAccess Jobs’)

g@s Note
If the editor does not want to display the configuration settings of the
profile before the export, it is possible to hide them via the Hide Details
button.

=

EVS - Export

v2.1.2
Sequence: DVCPRO HD 1080i PAL Ew

Profile: | Production '

4k
e

Show settings

!i Cancel :' C Export )

In order to expand the settings again, press the Show Settings button.

19
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6. How to Monitor the

Post-Processing
XTAccess Jobs

The EVS FCP Export Plug-in will launch a daemon application in a separate

window to display the status of each post-processing job.

List of Status:

Icon “grey”: The job is scheduled (waiting).

Icon “orange”: The job is being processed.

Icon “green”: The job has been successfully completed.

Icon “red”: The job has failed.

EVS Monitor

DVCPRO HD 1080i PAL
Export started on 24,/09/10 13:17:36

@ rewrap
job completed on 24/09/10 13:18:46

DVCPRO HD 10800 PAL
Export started on 24/09/10 13:19:46

§ rewrap
job completed on 24/09/10 13:21:59

DVCPRO HD 1080i PAL
Export started on 27/09/10 13:3%48

8 rewrap
job waiting

This window can display multiple export processes, as well as multiple post-
processing jobs for a specific export.
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7. Advanced Settings

7.1 INFO.PLIST & PARAM.PLIST FILES

All the advanced parameters are stored in the Info.plist file. This file can
be accessed in the \Library\Application Support\Final Cut
Pro System Support\Plugins\EVSExportPlugin bundle.

FYala) ] Plugins
Ll ) G = B ) (] a
DEVICES il Applications [ Agphcation Support = e (] Apple £ Custom Settngs [+ eieponpiugnounde BRETT
B Macintosh HD il Library L 0 Audio L Apple Qmaster Ll Plugins » Text Serambler.bundle
EETT) B Sequence . -Intramav 3 Caches [ Banskx Tithe 30 bundie
B ik [ System [ CalorPickers [l CrashReporter Tithe Crawl bundle
Emogin 202z & (1] & User Culde. formation 3 Colorsync @ evs Wecior Shape bundle % #

— [ users £ Components [0 Final Cut P._em Supgart =
SHARED 4 Compositions B Final Cur Stadie
o pestits = £ Cantextual Menu lems [ Garagesand
B oot 70 & [ Deskton Pictures i itV
[ o 3 Devetaper [ iiteMediaBrowsar Name EvSExportFiugin bu
= (3 Dictionaries i@ irmoto adia
B bebdsrmass [ Documentation Bl work 08
B bebmmosst (3 Extensians [ Macromedia

3 reesystems [ metservices
I peedeon £ Fans. (5 omel Group
L (3 Frameworks [ plasq

ACES W (L0 Gramhizs & ProApps

B3 Deskeon (3 image Cagture [ Prosedialc
% media £ nput Methods B Submntxaginfo

£ internet Plug-ing
o Apglications & Tores

J O £ Java
- (3 Keybaard Layouts
iy L]
S + ) Matintogh WD+ (i) Ubrary + (1] Applieation Support « [1] Final Cut Pro System Support + (1] Mluging + & 5 IVSExpetugin bundie
Lof & selected, 485,06 LB available &

To view the parameters, right-click the plug-in bundle and select the Show
Package Contents command.

The template Info.plistis stored in the sub-folder: Contents/
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NN | Info.plist

<?xml wersion="1.A" encoding="UTF-5"7=
<IDOCTYPE plist PUBLIC "-/fApples/DTD PLIST 1.8//EN" "http:/Awew.opple.com DTDs/
Propertwlist-1.8.dt4"=
=plist verszion="1.0"=
dicts
<kev=CFBund leDeve lopmentRegqion< keys
<=tring=English="string=
< eyv=CFBund leExecutab le< key=
=tring=EVSExportP lugin</string=
<kev=CFBund leGet InfoString=rkev=
w=tring=2.1.2</string=
ev=CFBund leldentifier</kevs
<k ey=CFBundlelnfaolictionaryversion</kev=
=tring=6.0< string=
<ev=CFBund [eMame</key=
<=tring=EMSExportP lugin=/string=
<eyv=CFBund lePackogeType</key=
<=tring=ENDL=/string=
<k ev=LFBund leShortVersionString</key=
=tring=2.1.2</string=
<kev=CFBund le5ignoture< kev=
<=tring=kevG/string=
<key=CFBund leVersion< kew>
=tring=7.2< ztring=
<ev=lobPazsThresho ld</key=
<zihteger=1=/integer=
tev=NiPrincipalCloss</keys
<=tring=EV3P luginControl ler</string=
<key=ProP lughictionaryVersion</kev>
=tring=l.0< ztring=
<kev=ProP lugbyvhomicRegistration</key=
“falze/=
<kev=ProP lugP luginlizt< kev=
OrTav=
adicts
ey lossione</key=
=tring=EYSPluginControl ler=/string=
“fkevzprotoco lName«< key=
ztring=PRODatalnterchange< string=
< dict=
<Aarray=
< dict=
='plist=

EVS does not recommend modifying this Info.plist file because it will be
overwritten by the package installer when re-installing the EVS FCP Export Plug-
in.

It is therefore recommended practice to copy Info.plist to Param.plist
and store it in:

/Library/Application Support/EVS/.

If a Param.plist file exists, it will be used instead of the Info.plist file.

When the Info.plist or Param.plist is modified, the FCP application
must be re-launched to take the new values into account.
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7.2

DELAY TO LAUNCH THE POST-
PROCESSING JOBS

The export process will create a QuickTime Reference Movie file.

This file format allows XTAccess to start reading the file during the export (while it
is still growing).

XTAccess will manage the head of the growing file to avoid accessing incomplete
video or audio frame.

Typically the EVS FCP Export Plug-in will send the Post-Processing job once a
minimum amount of exported Audio/Video is stored. It is possible to modify the
delay before sending the XML jobs.

The delay is stored in the Info.plist or Param.plist as the
JobPassThreshold:

e Each increment corresponds to a 1-second delay from the beginning of the A/V
creation to the initiation of the Restore job in XTAccess (this delay could vary
based on the storage, the complexity of the sequence (rendering process),
etc.)

e The default value is 1.

S_%% Note
When the exported QuickTime Reference file is created on a storage
accessed by XTAccess via Samba protocol (SAN, Mac local drive),
XTAccess jobs sometimes only process part of the file and the result file
or clip on EVS video server is not complete.

This behavior is due to Samba limitations on file notifications. This is
under investigation for improvement in a future release.

By selecting the option Send XML jobs when FCP export is over in the
post-processing job, the plug-in will send the XML jobs when the FCP
export process is completed. In this case XTAccess will only handle
exported QuickTime Reference files which are ‘closed’ (not growing).
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BUFFERIZATION OF A/V DATA DURING
EXPORT

By default, the Audio and video data are written in the exported QuickTime
Reference file when a chunk is complete.

e Video chunk: 1 frame of data

e Audio chunk: 1 second of data

It is also possible to bufferize A/V data before writing to the file. You need to
configure two parameters in the Params.plist file (in
/Library/Application Support/EVS/):

e VideoBufferSize:
o0 0: not activated. The video chunk size will be the default one (1 frame)

0 Value <> 0: video data will be bufferized in the size of the value expressed
in Bytes

e AudioBufferSize:
o 0: not activated. The audio chunk size will be the default one (1 second of

data)
0 Value <> 0: audio data will be bufferized in the size of the value expressed
in Bytes
Example

<dict>
<key>VideoBufferSize</key>
<integer>700000</integer>
<key>AudioBufferSize</key>
<integer>150000</integer>

</dict>

S_‘%;‘)? Note
Video and Audio bufferization is not available for Apple ProRes 422
codecs.
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1.4

XTACCESS METADATA

The creation of the XML metadata file along with the exported QuickTime
Reference file is based on a Metadata template stored in
\Library\Application Support\Final Cut Pro System

Support\Plugins\EVSExportPlugin bundle.

Right-click and select Show Package Contents to extend the plug-in bundle: The
Metadata template is stored in the sub-folder: Contents/Ressources/

[ Nala) [_|Resources =
EIESEIR © [0 a

DEVICES () 53 Contents » [ Info.plist =}.Acnon_Pressed e T Preview:
= Macintosh HD | [ Macos d li= :;Tdm:-t'ff an |
= e RAlD | I Pkginfa = ,.;fesse i |
I iDisk | [ Resources ¥ & Addu |
— | — bottom_bar_middle.png |
SHARED | _| bottom_bar_right.png |
B besdvn - | 2 closeBox.tif |
] xstore60170 a |l @/ closeBoxPressed.tif | XML

| | English.Iproj |
] aesde | |
[H] bebasrmoss | o GrayDot.tiff | Name MetaDataTemplate
a | 4| GreenDot.tiff | xml
L;‘ beb4srmossf il # logo EVS.png ! K|_m:l Dmnioutl!ner 3
B bebrdco1 8 MetaDataTemplate.xml I Size 4 KB on disk
= om Tromesoream | o e
@ all... lodifie 2
= 3 Profiles mom !| Last opened 12/07/10 12:39
PLACES @ RedDot.tff &
I Desktop | Remuve_l.’(essed tiff ;] Marainios.
A Medi =1 Remove.tiff hi

edia

o~ e L i YellowDot.tiff I
;}%Appllcalmns ) mmm—m—————— == —— = FEIES
[} Documents. v . Macintosh HD + (] Library + [ Applic: + [ Final € « [] Plugins + =~ EVSEx + [] Conter » [[] Resources » || MetaDataTemplate.xml

1 of 18 selected, 485,06 GB available

The default MetaDataTemplate.xml is shown below.
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;Mo | MetaDataTemplate.xml
<?xml wersion="1.8" encoding="UTF-3" standalone="no" 7=
<E¥3 Metadatas:-

eneral_Infoss
-File_Format_HiRes=4&File_Formotd= File_Format_HiRes=
-File_Growing=#Growing_Stotusk=/File_Growing=
=#File_File_Infos>
<HT_Of feet_TCxB-/wT_Of feet_TC=
0T _IN=BTC_THE/ ST _Th=
AT _OUT=%TC_0UT e W T _0OUT =
< T_TC_Swstem=XTC_Svystem¥/RT_TC_Svstemn:
< T_Mideo_Codec=#%Video_Codeck=“T_Video_Codec:
AT _Mideo_Std=AVideo_Stdi=/=T_Video_5td=
AT _Mideo_Inter laced=RKInter lacedi =T _Video_Inter laced= [
<2 T_Yideo_Svaten-tideo_Swatemb- XT_Video_Svstemns |
= xFile_File_Infos=
<fGeneral_Infos=
ALlipz_Infos= |
Llip=

<wFile_Clip_Infos=
=HAT_MarlD=sMar IDE=/»T_Var iD=
=AT_TC_Svstem=%TC_Systemb/sT_TC_Svstem=
T_0ffzet_TCoBa/WT_Of fzet_TCx
AT _Short _IN=%TC_IN%< eT_Short_IM=
=XT_Short _0UT=%TC_0OUT %= %T_Short _0OUT=
=XT_ClipName=%C | ipNamei=/xT_Cl ipMame=
=XT_Camera_Labe | =%Source_MWameko <T_Camera_Labe =
</wFile_Clip_Infos=
Adther_Clip_Infos=
<AzzetGUID=bssetGUIDE AssetGUID=-
<hzsetItenGUID=XAsset TtenCUI D Azzet T LemGUI D=
<hzset[tenMode=Xhsset TtenModek</Azzet T LemMode=
=uner =dlwner b= Ownet =
=LangC LipName=LongC L ipNamed-/LongC L iphame=
</0ther_Clip_Infos=
< Clip=
</Clipzs_Infos=

This template can be modified in order to customize the XML metadata file. When
the MetadataTemplate.xml file is modified, the FCP application must be
re-launched to take the new values into account.

Every time you re-install the EVS FCP Export Plug-in, this template will be
overwritten by the default template in the installshield. In order to preserve your
metadata template, you can copy the MetadataTemplate.xml file into the
following folder: /Library/Application Support/EVS/.

In case a MetadataTemplate.xml exists in /ZLibrary/Application
Support/EVS/, it will be used instead of the one in the default plug-in bundle.
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8. Limitations

The Sequence Name cannot contain special characters like “/" or non ASCII
128 characters.

Uncompleted Post-Processing jobs: When the exported QuickTime
Reference file is stored on a storage accessed by XTAccess via Samba
protocol (SAN, Mac local drive), XTAccess jobs sometimes only process part of
the file and the resulting file or clip on EVS video server is not complete. This
behavior is due to Samba limitations on file notifications. This is under
investigation for improvement in a future release.

The following workarounds are possible:

o Activate the FileReader NoBuffering setting on  XTAccess:
HKEY_LOCAL_MACHINE\SOFTWARE\EVS Broadcast
Equipment\Common\FileReader NoBuffering:

This setting aims at read a file without any buffering. It is recommended
for reading on a MacOS workstation via network (SMB). Set the value to 1
to activate it.

0 Store the exported QuickTime Reference file on a Windows-based storage

Select the option Send XML jobs when FCP export is over in the post-
processing job: The plug-in will send the XML jobs when FCP export
process is completed. In this case XTAccess will only handle exported
QuickTime Reference files which are ‘closed’ (not growing).

Cancel Jobs: This function cancels the FCP export of the sequence. When this
command is used, the plug-in sends a cancel job to XTAccess to cancel the
current scheduled or processed jobs. The cancel job is successful but the
jobs arrive too late to be taken into consideration by XTAccess. The cancel
feature will be reviewed in a future version.

FCP crashes: Some crashes of FCP have been observed when exporting
sequences (mainly in SD resolution). Such crashes are not related to the FCP
Export Plug-in. The same effect is observed when exporting the sequence
using the default Export to QuickTime Movie from the FCP export menu. This
issue is under investigation with Apple.

Mac connected to a SAN via AFP. The FCP Export Plug-in works properly
when connected to a SAN storage via AFP. The XML metadata must however
be stored on the SAN via SMB sharing and not AFP. AFP does not send any
notification to the IPD Scheduler and the media will not be displayed in IPD
the database. This works properly with the SMB protocol.
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Regional Contacts

AMERICA (NORTH & LATIN)

EVS Americas Tel: +1 818 846 9600 usa@evs.tv
East Coast Fax: +1 818 846 9601
EVS Americas Tel: +1 973 575 7811 usa@evs.tv

West Coast Fax: +1 973 575 7812
Tech. line: +1 973 575 7813 USAsupport@evs.tv
EVS Canada Tel: +1 514 750 7544 usa@evs.tv

Fax: +1 514 750 7518
Tech. line: +1 973 575 7813

USAsupport@evs.tv

ASIA & PACIFIC

EVS Australia

Tel: +61 02 9452 8600
Fax: +61 02 9975 1368
Mobile: +61 420 307 387

sales@evs-asia.com.hk

EVS China

Tel: +86 10 6808 0248
Fax: +86 10 6808 0246
Tech. line: +86 139 1028 9860

evschina@evs.tv

EVS Hong-Kong

Tel: +852 2914 2501
Fax: +852 2914 2505
Tech. line: +852 9401 2395

sales@evs-asia.com.hk

EVS India

Tel: 491 22 6697 2999
Fax: +91 22 2673 2092
Mobile: +91 98 9017 5958

sales@evs-asia.com.hk

EUROPE, MIDDLE EAST & AFRICA

EVS Belgium
Headquarters

Tel: +32 (0) 4 361 7000
Fax: +32 (0) 4 361 7099
Tech. line: +32 (0) 495 284 000

support@evs.tv
sales@evs.tv
marketing@evs.tv

EVS Brussels

Tel: +32 (0) 2 421.78.70
Fax: +32 (0) 2 421.78.79

evsbrussels@evs.tv

EVS Deutschland

Tel: +49 (0) 89 4111 949 00
Fax: +49 (0) 89 4111 949 99
Tech. line: +49 (0) 89 4111 949
77

germany@evs.tv
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EUROPE, MIDDLE EAST & AFRICA

EVS France

Tel: +33 1 46 99 9000
Fax: +33 1 46 99 9009
Tech. line: +33 1 46 99 9003

france@evs.tv

EVS Iberica

Tel: +34 91 490 3930
Fax: +34 91 490 3939
Tech. line: +34 91 490 3933

iberica@evs.tv

EVS Italy

Tel: +39 030 296 400
Fax: +39 030 294 3650
Tech. line: +39 334 631 1493

italy@evs.tv

EVS Middle East

Tel: +971 4 365 4222
Fax: +971 4 425 3501
Mobile: +971 50 887 8758

middle-east@evs.tv

EVS UK

Tel: +44 (0) 1372 387 250
Fax: +44 (0) 1372 387 269
Tech. line: +44 (0) 1372 387 266

uk@evs.tv

29


mailto:italy@evs.tv
mailto:middle-east@evs.tv
mailto:uk@evs.tv

EVS Broadcast Equipment
Liege Science Park

16, rue Bois St Jean
B-4102 Ougrée
Belgium

Corporate North & Latin America
Headquarters Headquarters

+32 4 361 7000 +1 973 575 7811

Evs To learn more about EVS go to www.evs.tv

Asia & Pacific
Headquarters

+852 2914 2501

.”///

Instant Tapeless TechnOlogy

Other regional offices
available on

www.evs.tv/contact
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